
Question 1 of 20 : Select the best answer for the question. 

1.   For what type of document would you use the landscape page orientation?  

     

   A. Three-column brochure 

   B. Business letter 

   C. Legal contract 

   D. School essay 

 

 

Question 2 of 20 : Select the best answer for the question. 

2.   After you enter the details for the first selected recipient in the New Address List dialog box, click 

_______ to add another recipient.  

     

   A. New Entry 

   B. Find 

   C. Customize Columns 

   D. OK 

 

 

Question 3 of 20 : Select the best answer for the question. 

3.   When you are in _______ cell in a row of a table, pressing Tab moves the insertion point to the first 

cell in the next row.  

     

   A. the center 

   B. any 

   C. the first 

   D. the last 

 

 



Question 4 of 20 : Select the best answer for the question. 

4.   Send a document as a PDF when  

     

   A. it contains material you don't want changed. 

   B. you want the recipient to make changes to the file. 

   C. it needs to be printed. 

   D. you save the file for the first time. 

 

 

Question 5 of 20 : Select the best answer for the question. 

5.   Pressing the Ctrl+Home keys moves the insertion point to the  

     

   A. beginning of a document. 

   B. next line of a document. 

   C. next word of a line. 

   D. beginning of a line. 

 

Question 6 of 20 : Select the best answer for the question. 

6.   In Step 2 of the mail merge process, you must be prepared to  

     

   A. preview the mail merge document. 

   B. insert merge fields into the document. 

   C. decide which type of mail merge document you'll be creating. 

   D. enter names, addresses, and other information into the New Address List table. 

  

 Mark for review (Will be highlighted on the review page) 

 

Question 7 of 20 : Select the best answer for the question. 

7.   _______ automatically moves the insertion point to the next line while you're typing.  



     

   A. Word placement 

   B. Word wrap 

   C. Smart Lookup 

   D. AutoCorrect 

 

Question 8 of 20 : Select the best answer for the question. 

8.   Click _______ to view each individual record of a mail merge document.  

     

   A. Finish & Merge 

   B. Preview Results 

   C. Edit Individual Documents 

   D. Print Documents 

  

 Mark for review (Will be highlighted on the review page) 

 

 

Question 9 of 20 : Select the best answer for the question. 

9.   The _______ has shortcuts to commonly used commands.  

     

   A. Status bar 

   B. ScreenTip 

   C. File tab 

   D. Quick Access toolbar 

  

 Mark for review (Will be highlighted on the review page) 

 

 

Question 10 of 20 : Select the best answer for the question. 



10.   Click/press _______ to remove the most recently typed text.  

     

   A. Delete 

   B. Undo 

   C. Esc 

   D. Redo 

  

 Mark for review (Will be highlighted on the review page) 

 

 

Question 11 of 20 : Select the best answer for the question. 

11.   On the Insert tab, select Table > _______ to create a table from selected text.  

     

   A. Quick Tables 

   B. Convert Text to Table 

   C. Insert Table 

   D. Draw Table 

  

 Mark for review (Will be highlighted on the review page) 

 

 

Question 12 of 20 : Select the best answer for the question. 

12.   On the Picture Tools Layout tab, you can preview results of the numerous styles, borders, effects, 

and layouts by _______ commands.  

     

   A. single-clicking 

   B. right-clicking 

   C. pointing to 

   D. double-clicking 



  

 Mark for review (Will be highlighted on the review page) 

 

 

Question 13 of 20 : Select the best answer for the question. 

13.   Which of the following dialog boxes is used for character formatting?  

     

   A. Styles 

   B. Page Setup 

   C. Paragraph 

   D. Font 

  

 Mark for review (Will be highlighted on the review page) 

 

Question 14 of 20 : Select the best answer for the question. 

14.   What is the action to select a single word and the space after it?  

     

   A. Press and hold Shift and click the mouse. 

   B. Triple-click the mouse. 

   C. Press and hold Ctrl and click the mouse. 

   D. Double-click the mouse. 

  

 Mark for review (Will be highlighted on the review page) 

 

 

Question 15 of 20 : Select the best answer for the question. 

15.   Clip art, WordArt, and shapes are all added from the _______ tab.  

     

   A. Insert 



   B. Design 

   C. Home 

   D. Layout 

  

 Mark for review (Will be highlighted on the review page) 

 

Question 16 of 20 : Select the best answer for the question. 

16.   You should type _______ space(s) after a period at the end of a sentence.  

     

   A. two 

   B. zero 

   C. one 

   D. three 

  

 Mark for review (Will be highlighted on the review page) 

 

Question 17 of 20 : Select the best answer for the question. 

17.   Use the Crop tool on an image to  

     

   A. rotate the image 90° to the right. 

   B. reposition the image. 

   C. enlarge the image. 

   D. remove unwanted areas from the image. 

  

 Mark for review (Will be highlighted on the review page) 

 

Question 18 of 20 : Select the best answer for the question. 

18.   What size paper should you use for a legal document?  

     



   A. 3″ × 5″ 

   B. 8½″ × 11″ 

   C. 7¼″ × 10½″ 

   D. 8½″ × 14″ 

  

 Mark for review (Will be highlighted on the review page) 

 

 

Question 19 of 20 : Select the best answer for the question. 

19.   Which one of the following features can control left and right indents using markers?  

     

   A. Status bar 

   B. Styles pane 

   C. Navigation pane 

   D. Ruler 

 

 

Question 20 of 20 : Select the best answer for the question. 

20.   _______ allows you to convert text to a graphic element.  

     

   A. SmartArt 

   B. Shapes 

   C. Clip art 

   D. WordArt 
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Question 1 of 20 : Select the best answer for the question. 

1.   Which function should be used to display a value based on a comparison?  

     

   A. IF 

   B. MIN 

   C. COUNT 

   D. AVERAGE 

 

Question 2 of 20 : Select the best answer for the question. 

2.   If you have long column labels with columns so wide that they affect the readability of a worksheet, 

you should first  

     

   A. leave the column labels as is. 

   B. decrease the column widths. 

   C. format the column labels. 

   D. consider how you could shorten the column labels. 

 

 



Question 3 of 20 : Select the best answer for the question. 

3.   Circular errors are caused by adding the cell name of a/an _______ cell to a formula.  

     

   A. adjacent 

   B. absolute 

   C. active 

   D. relative 

 

 

Question 4 of 20 : Select the best answer for the question. 

4.   Which is the correct formula to add the values in cells A1 and B1?  

     

   A. A1+B1 

   B. =SUM(A1+B1) 

   C. SUM(A1+B1) 

   D. =SUMA1+B1 

 

Question 5 of 20 : Select the best answer for the question. 

5.   The data selected to create a chart must include  

     

   A. formulas. 

   B. formatted cells. 

   C. blank rows and columns. 

   D. column titles and row labels. 

 

 

Question 6 of 20 : Select the best answer for the question. 

6.   How many worksheets display in the Excel window when you create a new blank workbook?  

     



   A. 3 

   B. 2 

   C. 4 

   D. 1 

 

 

Question 7 of 20 : Select the best answer for the question. 

7.   What would be a situation in which you could use an Excel chart to present your data?  

     

   A. Required ingredients for three different kinds of cake. 

   B. Compiling survey questions and answers from business clients. 

   C. What percentage of customer 101 buys product A, and what percentage of the same customer buys 

product B? 

   D. Listing team members on a soccer team with their address information. 

 

Question 8 of 20 : Select the best answer for the question. 

8.   You are able to drag a cell to a new location by pointing to the cell border until the pointer displays a 

_______ arrow, and then dragging the cell to the new location.  

     

   A. single 

   B. double-headed 

   C. four-headed 

   D. three-headed 

 

 

Question 9 of 20 : Select the best answer for the question. 

9.   When you see ##### in a cell, you should  

     

   A. decrease the cell height. 



   B. increase the cell width. 

   C. decrease the cell width. 

   D. increase the cell height. 

 

Question 10 of 20 : Select the best answer for the question. 

10.   You can tell a cell is the active cell when it has a  

     

   A. bold border and it is where the data you type will appear. 

   B. colored border and it is where the data you type will appear. 

   C. colored border and data you type will appear next to it. 

   D. bold border and data you type will appear next to it. 

 

 

 

Question 11 of 20 : Select the best answer for the question. 

11.   Press the _______ key to move to the next cell in a row.  

     

   A. Home 

   B. Enter 

   C. Page Down 

   D. Tab 

 

Question 12 of 20 : Select the best answer for the question. 

12.   The data selected to create a table must include  

     

   A. formatting. 

   B. row headers. 

   C. formulas. 

   D. column headers. 



 

Question 13 of 20 : Select the best answer for the question. 

13.   Which feature of the Excel window displays the contents of an active cell?  

     

   A. Ribbon 

   B. Quick Access Toolbar 

   C. Formula bar 

   D. Tell Me box 

 

Question 14 of 20 : Select the best answer for the question. 

14.   A _______ refers to the entire Excel file.  

     

   A. sheet 

   B. workbook 

   C. worksheet 

   D. spreadsheet 

 

 

Question 15 of 20 : Select the best answer for the question. 

15.   You can apply several different worksheet themes from which tab?  

     

   A. Insert 

   B. Home 

   C. File 

   D. Page Layout 

 

 

Question 16 of 20 : Select the best answer for the question. 

16.   Which key removes all data from an active cell with one click?  



     

   A. F2 

   B. Delete 

   C. Tab 

   D. Esc 

 

Question 17 of 20 : Select the best answer for the question. 

17.   The mathematical order of operations is used in Excel when formulas are evaluated. This order of 

operations states the order to be  

     

   A. exponentiation, multiplication and division, addition and subtraction. 

   B. multiplication and division, addition and subtraction, exponentiation. 

   C. multiplication and division, exponentiation, addition and subtraction. 

   D. addition and subtraction, multiplication and division, exponentiation. 

 

 

Question 18 of 20 : Select the best answer for the question. 

18.   Create a cell reference in a formula by typing in the cell name or  

     

   A. right-clicking the cell. 

   B. clicking the row where the cell is located. 

   C. clicking the column where the cell is located. 

   D. clicking the cell. 

 

 

Question 19 of 20 : Select the best answer for the question. 

19.   When long labels are required, which of these commands can you use to improve readability of a 

worksheet?  

     



   A. Conditional Formatting 

   B. Merge & Center 

   C. Sort & Filter 

   D. Wrap Text 

 

 

Question 20 of 20 : Select the best answer for the question. 

20.   Once you have selected the range of cells for your table data, from which tab can you open the 

Insert Table dialog box?  

     

   A. Layout 

   B. Review 

   C. Insert 

   D. Home 

Question 1 of 20 : Select the best answer for the question. 

1.   Within the Chart Design tab, which section is used to change the data of a previously created chart?  

     

   A. Change Chart Type 

   B. Select Data 

   C. Switch Row/Column 

   D. Edit Data 

 

 

Question 2 of 20 : Select the best answer for the question. 

2.   Which chart element provides the boundaries of the graphic?  

     

   A. Chart area 

   B. Slices 

   C. Legend 



   D. Chart elements 

 

 

Question 3 of 20 : Select the best answer for the question. 

3.   If your audience seems confused about a previous slide, what's the best way to jump back to a 

previous point in the presentation?  

     

   A. Zooming into the slide 

   B. Clicking See all slides 

   C. Annotating with the pen or highlighter 

   D. Using the laser pointer 

 

Question 4 of 20 : Select the best answer for the question. 

4.   What's the purpose of Speaker Notes?  

     

   A. They're required for each slide. 

   B. They're presented to both the speaker and the audience. 

   C. Speaker Notes contain additional visual elements. 

   D. They provide additional detail for the presenter to use as speaking cues. 

 

Question 5 of 20 : Select the best answer for the question. 

5.   While typing, a red squiggly line appears. What does that signify?  

     

   A. A grammatical error has been identified. 

   B. An alternate word from the thesaurus is recommended. 

   C. A fatal error and the word must be deleted and retyped. 

   D. A possible spelling error has been identified. 

 

Question 6 of 20 : Select the best answer for the question. 



6.   Which view is most commonly used to make edits to a slide?  

     

   A. Slide Sorter 

   B. Slide Show 

   C. Notes Page 

   D. Normal 

 

Question 7 of 20 : Select the best answer for the question. 

7.   A media file refers to what kind of file?  

     

   A. Image 

   B. Clip art 

   C. Audio 

   D. Shapes 

 

 

Question 8 of 20 : Select the best answer for the question. 

8.   Which tab is used to insert a chart?  

     

   A. Format 

   B. Insert 

   C. Animations 

   D. Add-ins 

 

 

Question 9 of 20 : Select the best answer for the question. 

9.   To move the insertion point on a table to a different cell, which key should be pressed?  

     

   A. Tab 



   B. Enter 

   C. Delete 

   D. Home 

 

 

Question 10 of 20 : Select the best answer for the question. 

10.   Which view is easiest and most recommended for changing the order of the slides?  

     

   A. Slide Sorter View 

   B. Reading View 

   C. Slideshow View 

   D. Slide Master View 

 

 

Question 11 of 20 : Select the best answer for the question. 

11.   When a transition is applied to a slide, how is it visible to the user?  

     

   A. A numbered box appears next to the thumbnail. 

   B. A Play animation icon appears next to the thumbnail. 

   C. A numbered box appears on the slide. 

   D. A Play animation icon appears on the slide. 

 

Question 12 of 20 : Select the best answer for the question. 

12.   A _______ chart compares differences in values by showing vertical bars sized relative to the values 

in the data series.  

     

   A. pie 

   B. column 

   C. line 



   D. bar 

 

 

Question 13 of 20 : Select the best answer for the question. 

13.   When editing the master slides, if you edit the layout on the title page, those changes appear on  

     

   A. all title slides in the presentation. 

   B. all slides in the presentation. 

   C. only the first title slide in the presentation. 

   D. all slides in the current and future presentations. 

 

 

Question 14 of 20 : Select the best answer for the question. 

14.   From the Table Style Options area of the Design tab, you select Banded Columns. What will happen 

to your table?  

     

   A. Every other column will have a border added to it. 

   B. Each column will split in half. 

   C. Every other column will be shaded. 

   D. Every other column will be merged with its neighboring column. 

 

Question 15 of 20 : Select the best answer for the question. 

15.   Printed versions of your presentation that contain the slides and blank lines below are called  

     

   A. handouts. 

   B. speaker notes. 

   C. bullet points. 

   D. outlines. 

 



 

Question 16 of 20 : Select the best answer for the question. 

16.   When a slide is inserted, it appears  

     

   A. at the end of the presentation. 

   B. after the selected slide. 

   C. at the beginning of the presentation. 

   D. before the selected slide. 

 

Question 17 of 20 : Select the best answer for the question. 

17.   What does the Chart Elements option allow you to change?  

     

   A. Axis titles 

   B. Style 

   C. Values 

   D. Color 

Question 18 of 20 : Select the best answer for the question. 

18.   How can you add and remove categories from a previously created chart?  

     

   A. Click the Chart Filters button. 

   B. Click the Chart Elements button. 

   C. Click the Chart Styles button. 

   D. Click the Format tab. 

 

Question 19 of 20 : Select the best answer for the question. 

19.   PowerPoint creates visuals called  

     

   A. slides. 

   B. text. 



   C. charts. 

   D. images. 

 

 

Question 20 of 20 : Select the best answer for the question. 

20.   Presenter View is used to  

     

   A. share additional information visually with the audience. 

   B. set up pre-established annotation notes on the slide. 

   C. provide a list of keyboard shortcuts that can be used by the presenter. 

   D. provide speaker notes to the presenter. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 


